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Quark XML Author ReadMe 4.6.1

The staff of Quark Software Inc. would like to thank you for selecting Quark® XML Author

to be your XML authoring solution.

Quark XML Author is a mature XML editing solution in intelligence, pharmaceuticals,

European governments, and now DITA.

Quark XML Author supports the following Display Languages within Microsoft Word:

English, French, Japanese and Spanish.

This document provides details on system requirements, installation procedures, changes

in the software, and technical support information.
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Quark XML Author System
Requirements

The following provides the hardware and software requirements of Quark XML Author

for Microsoft® Word.

Hardware for Word 2003
Quark XML Author requires the following minimum hardware configuration:

• 500 MHz processor

• 512MB of RAM (1GB or more recommended)

• 1GB of available hard disk space

• Display with 1024 x 768 or higher resolution monitor

• Peripherals suitable for Microsoft® Word authoring

• DVD-ROM drive for installation from DVD (not required for installation from download)

Software for Word 2003
Quark XML Author requires one of the following operating systems:

• Windows® XP Professional with Service Pack 3 (SP3) or higher

• Windows 7® 32-bit (Enterprise, Professional or Ultimate)

• Windows 7® 64-bit (Enterprise, Professional or Ultimate)

Quark XML Author requires Microsoft Office Word 2003 Professional Service Pack 3 (SP3)

(released 9/17/2007) or higher.

Quark XML Author provides localized language support for:

• English

• French

• Spanish

• Japanese
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Quark XML Author supports the following IME’s for editing Japanese language content:

• Microsoft Office IME 2010 32-bit

In addition, the following components are required for installation:

• .NET Programmability Support. See "Enabling .NET Programmability Support Word 2007 /

2010”

• .NET Framework 3.5. SP1 and .NET Framework 4.x or higher. Both versions must be

installed. .NET Framework supports the installation of both 3.5 SP1 and 4.x versions on

the same system. It is available for download at Microsoft’s Download Center:

www.microsoft.com/downloads

• Shared Add-in Support Update for the Microsoft .NET Framework 2.0 (KB908002). It is

available for download at Microsoft’s Download Center:

http://support.microsoft.com/kb/908002

• If you want to author math equations, then Design Science MathType™ version 6.5 or

higher is required.

Math equations are saved to MathML format and to a specified image format. In addition,

performance can be enhanced if math equations are also saved to a binary OLE format.

Once the required installation of Word is complete, you may install Quark XML Author.

Hardware for Word 2007
Quark XML Author requires the following minimum hardware configuration:

• 1 GHz 32-bit (x86)processor

• 1GB of RAM (2GB or more recommended)

• 1GB of available hard disk space

• Display with 1024 x 768 or higher resolution monitor

• Peripherals suitable for Microsoft® Word authoring

• DVD-ROM drive for installation from DVD (not required for installation from download)

Software for Word 2007
Quark XML Author requires one of the following operating systems:

• Windows® XP Professional with Service Pack 3 (SP3) or higher

• Windows 7® 32-bit (Enterprise, Professional or Ultimate)

• Windows 7® 64-bit (Enterprise, Professional or Ultimate)

• Windows 8® 32-bit

• Windows 8® 64-bit

• Windows 8.1® 32-bit
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• Windows 8.1® 64-bit

Quark XML Author requires Microsoft Office Word 2007 Service Pack 2 (SP2) or higher.

Quark XML Author provides localized language support for:

• English

• French

• Spanish

• Japanese

Prior to Windows 8, Quark XML Author Japanese requires Microsoft Office IME 2010

32-bit.

For Windows 8.0 and 8.1, Quark XML Author Japanese requires Hotfix Rollup for Office

IME (Japanese) 2007 (KB938574) (32-bit)

(http://www.microsoft.com/en-us/download/details.aspx?id=1592).

In addition, the following components are required for installation:

• .NET Programmability Support. See "Enabling .NET Programmability Support Word 2007 /

2010”

• .NET Framework 3.5. SP1 and .NET Framework 4.x or higher. Both versions must be

installed. .NET Framework supports the installation of both 3.5 SP1 and 4.x versions on

the same system. It is available for download at Microsoft’s Download Center:

www.microsoft.com/downloads

• Shared Add-in Support Update for the Microsoft .NET Framework 2.0 (KB908002). It is

available for download at Microsoft’s Download Center:

http://support.microsoft.com/kb/908002

• If you want to author math equations, then Design Science MathType™ version 6.5 or

higher is required.

Math equations are saved to MathML format and to a specified image format. In addition,

performance can be enhanced if math equations are also saved to a binary OLE format.

Once the required installation of Word is complete, you may install Quark XML Author.

Hardware for Word 2010
Quark XML Author requires the following minimum hardware configuration:

• 1 GHz 32-bit (x86) processor or 1 GHz 64-bit (x64) processor

• 2GB of available hard disk space

• 1GB of RAM (2GB or more recommended)

• Display with 1024 x 768 or higher resolution monitor

• Peripherals suitable for Microsoft® Word authoring
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• DVD-ROM drive for installation from DVD (not required for installation from download)

Software for Word 2010
Quark XML Author requires one of the following operating systems:

• Windows® XP Professional with Service Pack 3 (SP3) or higher

• Windows 7® 32-bit (Enterprise, Professional or Ultimate)

• Windows 7® 64-bit (Enterprise, Professional or Ultimate)

• Windows 8® 32-bit

• Windows 8® 64-bit

• Windows 8.1® 32-bit

• Windows 8.1® 64-bit

Quark XML Author requires Microsoft Office Word 2010 32-bit.

Quark XML Author provides localized language support for:

• English

• French

• Spanish

• Japanese

Prior to Windows 8, Quark XML Author Japanese requires Microsoft Office IME 2010

32-bit.

For Windows 8.0 and 8.1, Quark XML Author Japanese requires Office 2010 Japanese IME

add-in for Windows 8 (http://www.microsoft.com/en-us/download/details.aspx?id=35839).

In addition, the following components are required for installation:

• .NET Programmability Support. See "Enabling .NET Programmability Support Word 2007 /

2010”

• .NET Framework 3.5. SP1 and .NET Framework 4.x or higher. Both versions must be

installed. .NET Framework supports the installation of both 3.5 SP1 and 4.x versions on

the same system. It is available for download at Microsoft’s Download Center:

www.microsoft.com/downloads

• Shared Add-in Support Update for the Microsoft .NET Framework 2.0 (KB908002). It is

available for download at Microsoft’s Download Center:

http://support.microsoft.com/kb/908002

• If you want to author math equations, then Design Science MathType™ version 6.7 or

higher is required.

Math equations are saved to MathML format and to a specified image format. In addition,

performance can be enhanced if math equations are also saved to a binary OLE format.
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Once the required installation of Word is complete, you may install Quark XML Author.
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Quark XML Author Installation
Procedure

Installing Quark XML Author is a straightforward process. The installation wizard will

guide you through each step of the install.

Before you begin to install Quark XML Author, be certain that all required software,

including Microsoft Word, has already been installed. Also, run Office Updates at

Microsoft.com to ensure the latest version is installed. Quark XML Author explicitly uses

these latest features. Close Microsoft Word and Microsoft Office.

To install Quark XML Author:

1 Ensure that you have internet access. If any of the common Microsoft libraries are not

installed on your system, the installation process attempts to download them.

2 If previous versions of Quark XML Author have been installed, perform the following

steps.

a) Use Control Panel to uninstall all previous versions and patches.

b) Use Windows Explorer to delete the installation folder.

The default installation folder is:

• For 32-bit: C:\Program Files\Quark\Quark XML Author\

• For 64-bit: C:\Program Files (x86)\Quark\Quark XML Author\

3 From the installation media, double-click the setup.exe file and follow the instructions on

the screen.

Quark XML Author has been successfully installed.
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Enabling .NET Programmability
Support Word 2003

Quark XML Author requires Word programmability through the .NET Framework. You

can enable this feature through the Windows Control Panel. The Microsoft description of

this feature reads, “Primary interop assembly that allows Microsoft Office Word

programmability with .NET Framework version 1.1 or greater.”

To enable support for .NET programmability:

1 Choose Control Panel > Add or Remove Programs.

2 Locate and select Microsoft Office 2003.

3 Click Change.

4 In the Change your installation of Microsoft Office dialog box, click Add or Remove

Features.

5 Click Next.

6 Ensure that Word is checked.

7 Check Choose advanced customization of applications.

8 Expand Microsoft Office > Microsoft Office Word > .NET Programmability Support.

9 Check Run from My Computer.

10 Click Update.

The configuration process starts.

11 Click Close.

Word is configured for programmability with the .NET Framework.
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Enabling .NET Programmability
Support Word 2007 / 2010

Quark XML Author requires Word programmability through the .NET Framework. You

can enable this feature through the Windows Control Panel. The Microsoft description of

this feature reads, “Primary interop assembly that allows Microsoft Office Word

programmability with .NET Framework version 1.1 or greater.”

To enable support for .NET programmability:

1 Choose Control Panel > Add or Remove Programs.

2 Locate and select Microsoft Office 2007 or Microsoft Office 2010, respectively.

3 Click Change.

4 In the Change your installation of Microsoft Office dialog box, click Add or Remove

Features.

5 Click Continue.

6 Ensure that Word is checked.

7 Check Choose advanced customization of applications.

8 Expand Microsoft Office > Microsoft Office Word > .NET Programmability Support.

9 Check Run from My Computer.

10 Click Continue.

The configuration process starts.

11 Click Close.

Word is configured for programmability with the .NET Framework.
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Changes in this Version

This section describes major changes, new features, and new support in this version of

Quark XML Author.

The details provided apply to the core Quark XML Author functionality which is a

component of all Quark Content Management System Adapters.

Changes 4.6.1
Before content is pasted, tracked deleted content is filtered. This applies to local content

not referenced content.

Changes 4.6
Undo and Redo

Redo is now supported. The Undo and Redo features within an XML Author session operate

similar to Undo and Redo within a standard Word authoring session. For every Undo

action that is supported in Quark XML Author, Redo is also supported. The Repeat Last

Action feature is not supported. In Word, Repeat is integrated with the Redo feature.

Cross-reference

Cross-references are allowed in Word documents that are embedded in a Quark XML

Author document. A cross-reference is added to a word or phrase, and has a target or

destination. In an embedded Word document, the destination may be a specified location

within the same document or a location within a Quark XML Author document. The

Quark XML Author document may be the parent of the embedded Word document or a

different Quark XML Author document. The user is able to click on a cross-reference and

follow the link to a specified location within a document.

Emphasis and Metadata

XML Author now supports the ability to apply (remove) emphasis to text within an

embedded Word document. In addition, XML Author now supports metadata for content

within an embedded Word document. The user and the system can add (remove) metadata

on a table, table row, table cell, paragraph, and emphasis. These capabilities are currently

not distributed in any out-of-the-box solutions.

Extensibility Interface and Core
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Significant enhancements have been made to the XML Author Extensibility Interface and

Core to provide new functionality in embedded Word documents. In summary, these

enhancements facilitate the new cross-reference and metadata features. The following are

the technical details for the enhancements:

• EmphasisAction is a new EI delegate available to call from EI Methods. Previously, this

feature only existed as an Internal Class. This functionality is available to both XML Author

documents and to embedded Word documents.

• InsertEmphasis is an existing EI delegate that previously was only available to XML Author

documents, but now is also available to embedded Word documents.

• RemoveContentItem is a new EI delegate. This feature is used to delete a specified Word

Content Control in an embedded Word document. This is necessary if emphasis is removed

or the metadata on a piece of content is removed. This applies to embedded Word

documents only.

• XOMCurrentNode is available in an (embedded) OLE Word Document. When an OLE

Word Document is the active document, XOMCurrentNode corresponds to the current

node within the XOM of the OLE Word Document.

• XOMRoot is available in an (embedded) OLE Word Document. When an OLE Word

Document is the active document, XOMRoot corresponds to the root of the parent XML

Author document that owns the OLE Word document.

• AccessMode is available in an (embedded) OLE Word Document. When an OLE Word

Document is the active document, this is the access mode of the parent XML Author

document that owns the OLE Word Document.

• InsertXACrossref is a new Internal Class that is available to embedded Word documents.

It is used a cross-reference link from an embedded Word document to a target destination

in an XML Author document. The destination may be in the document that is the parent

of the embedded Word document or it may be another XML Author document.

• The XML Author configuration for embedded Word documents now includes the ability

to configure Ribbon buttons.

General Changes:

The out-of-the-box file-based reference-resolver has been re-architected.

Quark.XA.EI.DITA-cms.dll is replaced with Quark.XA.EI.ReferenceResolver.dll.

The Transform Engine now supports the serialization of Smart Content hyperlinks.

When deleting an element with many dependents, the delete confirmation message can

be long. Add intelligence to display a more concise message. For example, when deleting

a table, don't list every single child element of the table. Sometimes displaying just the

parent element name is sufficient.

The XML Author Application configuration now supports a new ImageFilePath entry. This

local path specifies where to store embedded images when the system is exporting an

embedded Word document.
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The Quark XML Author configuration for Word 2010 Backstage now supports document

type specific configurations.

In the Quark XML Author configuration schema, move TabShare from being configured

at the application-level to being configured at the document-level.

The KeepWithNext feature now supports table rows.

Changes 4.5.1
Performance enhancements have been made in various features for equations. To take

advantage of these enhancements, configurations must be updated to use the saveOLEObject

feature. In addition, the saveMTEF feature is no longer supported and must be removed

from all configurations or schema validation error will occur. Quark recommends that

configurations that use saveMTEF should be migrated to use saveOLEObject. Technical

Details: The Quark XML Author file format has changed for documents containing

equations. The change was required to reliably preserve and render MathType equation

dimensions. The change is backward compatible. Legacy documents open normally with

the new configuration, and are automatically converted to the new format when saved.

Files saved using Quark XML Author version 4.5.1 or higher will no longer contain the

<MTEF> node. If a configuration uses saveOLEObject, then saved files will contain an

<OLEObject> and an <OLEImage> node.

Changes 4.5.0.1
The Keep With Next feature now supports table rows.

Changes 4.5
The Table Styles feature allows the user to change the style of an existing table. This is

available in a solution and table definition in which multiple table styles have been defined.

The Word Table feature allows the user to embed a fully functional Word document within

an XML Author document. The user can edit the Word document without restrictions,

but the intended use of this feature is to support embedded large/complex tables. The user

is able to insert Word tables at locations within the document structure that are allowed

by the rules of the document type. At these locations, the Context Menu and insertables

list displays "Word Table". When the user inserts a Word Table, the system displays a scaled

rendering of the embedded table on the canvas in the XML Author document. The scaled

rendering displays the content of the first "printed" page of the table. To view or edit, the

user double-clicks the table object. A new Word window is launched that contains the

table content and is ready for viewing or editing.

Changes 4.4.1.1
A Word command is a Word feature that may be invoked by the user. Word commands

are assigned to the buttons and menus in the user interface. A single Word command can

therefore be invoked from multiple locations such as the Ribbon or Quick Access Toolbar.

XML Author configurations have been enhanced to support all of the following:
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A Word command can be enabled/disabled at the command level. This enables/disables

the command across all occurrences in the Word user interface including: Ribbon, Toolbar,

Menus, Backstage and Quick Access Toolbar.

A Word command can be repurposed (to a new function) at the command level. This

repurposes the command to a single new function across all occurrences in the Word user

interface including: Ribbon, Toolbar, Menus, Backstage, and Quick Access Toolbar.

The visibility of a Word command is not controlled at the command level, but rather at

the individual button or menu.

The following visibility settings are supported. A button may be configured as:

• visible in all Word and XML Author documents

• not visible in all Word and XML Author documents

• only visible in XML Author documents

• only visible in Word documents

Changes 4.4
Quark XML Author now supports Windows 8.

The default element functionality has been enhanced so that new table cells are

automatically populated with text elements. This ensures that users will have a consistent

and reliable user experience as they navigate a table and type in cells.

The Disable Template Add-ins feature can be used to disable all ribbon tabs of third-party

add-in software so that the user cannot execute a feature that might corrupt a Quark XML

Author document.

The Cell Shading feature allows the user to set the background color for a selection of one

or more table cells.

Changes 4.3.3.2
The default element functionality has been enhanced so that new table cells are

automatically populated with text elements. This ensures that users will have a consistent

and reliable user experience as they navigate a table and type in cells.

Fixes 4.3.2
Image processing has been enhanced to prevent the insertion of image files named with

the incorrect file extension and image files that contain incorrect binary signatures.

Fixes 4.3.1
HTML table functionality now includes support for row merge (rowspan).
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Fixes

This section describes significant fixes in this version of Quark XML Author.

The details provided apply to the core Quark XML Author functionality which is a

component of all Quark Content Management System Adapters.

Fixes 4.6.1
In non-English Business Documents configurations, the Simple Table template needs to

be updated to match the English configuration.

The performance of the Accept All Changes and Reject All Changes features needs to be

improved when many changes are present. This applies to tracked text and whole content

element changes.

When the characters é ó ú are typed, nothing is displayed on the canvas.

New content references created with the Create Component feature should have a grey

background, but instead the background is red.

Pressing Enter to the left of an endnote splits paragraph, but then displays endnote text

rather than the endnote reference.

After copying a section (heading 1 plus paragraph) in a Word, pasting the section into a

XML Author document may occur at a different section level than was selected by the

user.

With Track Changes and Revision Balloons on, copy paste of text with endnote displays

"Deleted ¶" revision balloon rather than pasting text with endnote.

With Track Changes on, when typing over selected text, the new text should be inserted

after the tracked deleted text, but instead is inserted before.

Undo of deleting footnote text fails.

In a table cell, pressing Enter to the immediate left of or inside of emphasized text displays

the wrong emphasis on the resulting paragraphs. The XML is correct though and displays

correctly when the document is re-opened.

If there are multiple levels at which the insertAfter feature could insert a new element, it

should insert the element as the first/inner-most element. Instead nothing happens.

Comment is lost after undo of redo of deleted commented text.
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Accepting tracked changes for a deleted large table takes a long time.

When an item's indent is increased or decreased, the change is not reflected in the Styles

control.

With Track Changes on, replacing existing nodes using the Replace Node Delegate no

longer tracks deletions only insertions.

When the user opens a Quark XML Author document via double-click, the Tagging Panel

does not display on some machines.

Images that have been inserted using the Smart Paste feature are not serialized properly

on document Save. When the document is re-opened, the image path is incorrect and the

"missing image" icon is displayed on the Word canvas.

Images dimensions are being reduced by one pixel each time the document is opened.

Undo of deleting inline image (or equation) within emphasis fails. Images is missing when

document is re-opened.

In Japanese Word 2010, if a footnote contains the text that is the target of the Find feature,

an "Unhandled Exception" error is displayed.

With Structured Tables, endnotes are displayed above table notes rather than below.

With tracked inserted paragraphs, undo redo of Accept All Changes fails.

Some configurations of content reference elements result in references that are editable

rather than read-only. Technical Details: This occurs if the referenceAttribute definition

contains an xmlname.

When emphasized text is pasted into existing emphasized text, nesting is not performed

correctly.

If both an embedded Word table and a non-embedded Word table are selected and deleted,

the canvas displays correctly, but embedded Word table is not deleted from the XML.

Table headers configured to allow only one row are allowing the user to add multiple rows.

Deleting the character that immediately follows an endnote also deletes endnote rather

than only deleting the character.

Using click and drag to resize the Comments or Reviewing Pane locks the mouse and

requires pressing ESC to release the mouse.

Link Management Task Pane button has incorrect spelling and is missing one tooltip.

In certain scenarios, the AutoRecover feature fails after XML Author crashes.

Text typed immediately after a hyperlink is formatted as a hyperlink even though it is not

part of the hyperlink.

Simple Table should be configured with widow-orphan setting, but is not.

The Cell Shading feature is only shading selected text rather than the entire contents of

the current cell.
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Embedded Word documents should not be displayed in Recent Documents list.

For the Replace Picture feature, Undo twice Redo twice fails.

XML Author is using default resources rather than English resources.

Copy and paste of table columns that have horizontal and vertical merges corrupts

document.

Insert Hyperlink is not properly enabled/disabled when nested hyperlinks have been

inserted and then multiple paragraphs are selected.

For delete inline equation, undo redo fails.

For conref of equation, undo redo fails.

Removing inline condition displays "Unhandled Exception" error message.

When pasting a table from a standard Word document into a Quark XML Author document,

the table structure is distorted.

For insert inline equation within text in a table cell, undo redo fails.

For insert table row, undo redo fails with Track Changes on.

In a Structured Table with endnotes or table notes, undo redo of Replace All corrupts the

document.

For Insert Variable Text dialog, process Enter as accept selection and process ESC key as

cancel dialog.

Incorrect values for conditions are displayed when content controls are selected.

For delete of a selection of tracked and non-tracked content, undo redo fails.

With selection in variable text, canceling the Insert/Modify Condition dialog displays

"Unhandled Exception" error message.

Opening and re-saving a pre-4.6 document adds "id" to conrefs rather than only "xml:id".

Table cell content control titles have been removed to overlapping "Row" and "Cell" titles.

Inline content controls are missing titles on content elements other than tables, rows and

cells.

In an embedded Word document, the Insert Ribbon group label "Links" is missing.

Fixes 4.6.0.1
Accepting tracked changes for a large deleted table takes too long.

When the user opens a Quark XML Author document via double-click, the Tagging Panel

does not display on some machines.
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Fixes 4.6
Pasting an image from a standard Word document into an XML Author document fails

and corrupts the document. Technical Details: The image element is created with an href

attribute instead of xlink:href.

The Accept (and Reject) All Changes feature fails for tracked inserted images.

The Undo feature fails for Replace All if the replaced text occurs both inside and outside

of a footnote.

If both Track Change and Detect Language Automatically are on and the user pastes text

that is in a language different from the document, the system displays "{ DOCVARIABLE

PostTextIA3 }" on the Word canvas. Content is not affected.

Content references within the same document as the source content are being assigned

the same ID as the source element, but instead should be assigned a unique ID.

With Track Changes on, if text is typed in an Empty, the first character is not tracked as

an insertion. Any additional typed text is properly tracked.

With Track Changes on, the Replace All feature goes into an infinite loop if text is replaced

within a footnote.

The Replace feature is losing the emphasis when it replaces emphasized text.

In Japanese Windows, if the Refresh feature is invoked on an image, that image can no

longer be resized.

After converting a list to a different list type, the Delete feature will fail to delete all selected

items in that list.

On a given list, if the ChangeTo feature is invoked from the Ribbon button, the order of

the list items is changed.

An unexpected line break is being prepended to table cell text when it is saved. Technical

Details: This applies when the paragraph is defined with childTextNode set to "true".

Even though tables are configured with no borders, borders are displayed after cells are

split.

When the cursor is inside of tracked inserted text and the Delete key is pressed, the cursor

moves to the right one character instead of remaining in the same position.

The prompt message for deleting multiple dependents is missing line breaks before the

list of dependents.

With Track Changes on, splitting of tracked deleted text should create tracked deleted text

in the new paragraph, instead it creates tracked inserted text.

The Context Menu for Business Document Sections is inappropriately displaying various

numbering commands: Restart, Continue, and Set Numbering.

The Max Length setting is not being enforced if the user is typing within a table.
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Several Backspace key combinations are not recognized as ShortCutKeys and are processed

incorrectly.

With Track Changes, Undo of Reject All Changes fails. Some tracked changes in the

document are not correctly reinstated.

For transforming of Smart Content, if adjacent text runs have the same properties then

merge the text into a single run. The properties in question must be ones that the Transform

Engine does not transform such as font and font size.

In several use cases, the Increase and Decrease Indent buttons are incorrectly enabled.

Enabling is not honoring established indent rules logic. In several use cases, the Emphasis

control is incorrectly enabled.

There are several methods for copying tables that cause the Paste button to be disabled or

cause the Ctrl+V accelerator key to fail.

For Cals Tables with borders use cases, the Transform Engine is not accurately saving the

colsep attribute.

Occasionally, when an image is inserted the image is displayed properly, but the height

and width attributes are changed. This only applies to windows metafile graphics.

Backstage View items that are configured to only be visible when Word is active are visible

when Quark XML Author is active.

Configuration for DITA image element is missing several attributes. For example, widthdpi

and heightdpi.

For the Business Documents and DITA solutions, set the default language in the Word

templates. Technical Details: In the styles.xml in the dotx package, ensure that the default

language is correct for each language. For example, w:val="en-US" for US templates and

w:eastAsia="ja-JP" for Japanese templates.

Update the Business Documents solution to use standard/reserved XML namespaces for

id and href, xml:id and xlink:href respectively.

In Business Document solutions, the attribute "Callout" is displayed in the Attributes Panel.

In table cells, empty text elements are not saved with the document. Technical Details:

childTextNode is not being preserved.

The Refresh Reference feature cannot be invoked in read-only documents.

With Track Changes, if a tracked insertion is selected and typed over, the text is corrupted.

If a misspelled word followed by certain punctuation marks occurs at the end of a paragraph

and the user right-clicks next to that word, the right-click feature fails. If the punctuation

mark is a period or exclamation mark, the following error message is displayed: "Cannot

perform right-click operation." If the punctuation mark is a question mark, the Context

Menu that displays is missing spelling suggestions.
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If paragraphs are configured so that when the user presses the Enter key, a new element

is not "inserted after" the paragraph, an erroneous ÿ character is inserted. This character

is visible if Show Paragraph Marks is on.

With Track Changes, if the user deletes a character within a tracked insertion, the cursor

is positioned incorrectly. The cursor should remain at the deletion, but instead is positioned

one character to the right.

If multiple paragraphs are selected, the Insert Hyperlink button should not be available.

Invoking the feature with this selection corrupts the document.

With Track Changes and Show Revisions In Balloons on, the user splits a paragraph by

pressing Enter between words. The text to the right of the cursor is displayed in the new

paragraph. If the user moves the cursor to the end of the first (split) paragraph and presses

Enter, a blank paragraph should be created, but instead the new paragraph displays the

same text that was to the right of the cursor during the first split.

If the user converts a bulleted list to a numbered list using the Change To feature and then

attempts to delete the list, the list does not delete entirely.

With Track Changes on, if the user splits a paragraph, the text to the right of the cursor

should become tracked deleted text in the original paragraph, but instead becomes tracked

inserted text.

With Track Changes on, if the user splits emphasized text within a paragraph, the text to

the right of the cursor should become tracked deleted text in the original paragraph, but

instead becomes tracked inserted text. And the document is corrupted.

If the user converts part of a bulleted list to a numbered list using the Change To feature

on the Ribbon, one new list should be created, but instead multiple lists are created.

With Track Changes on, if the user converts a bulleted list to a numbered list using the

Change To feature and then attempts to delete the list, the list does not delete entirely.

With Track Changes and Detect Language Automatically on, if text is pasted that is in a

language different than the current document, a field code is displayed to the right of the

paragraph. The field code is not displayed when the document is re-opened.

If the user pastes an image as inline within a paragraph, a "Could not open document"

error message is displayed.

Undo fails for insert equation inline.

With Track Changes on, if the user splits emphasized text within a paragraph, a second

paragraph is created that contains the text to the right of the cursor, but the emphasis is

missing from the second paragraph.

With Track Changes on, items are added to a numbered list by pressing Enter. If a subset

of the items at the end of the list are selected and deleted, the Delete feature fails to remove

these items entirely.
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For a tracked change Picture insert, if the user accepts the insertion and then invokes Undo,

Undo fails. The image is not reverted to a tracked insert, a second image is inserted and

the document is corrupted.

For all supported languages, update the Quark copyright statement from 2013 to 2014 in

the About dialog box and in the Word 2010 Backstage.

Fixes 4.5.2
With Track Changes on, if the custom refresh data feature is invoked and the document

is saved, the document cannot be re-opened. A "violates number constraint" error message

displays. Technical Details: The ReplaceNode Delegate is not handling tracked changes

correctly.

Images that have been inserted using the Smart Paste feature are not serialized properly

on document Save. When the document is re-opened, the image path is incorrect and the

"missing image" icon is displayed on the Word canvas.

In the DITA solution, the Smart Paste command is missing when the clipboard contains

content copied from a standard Word document.

CMS Extensibility Interface is unable to upload images that have been inserted using the

Smart Paste feature.

On certain computers, if the user opens an XML Author document by double-clicking on

the file in Windows Explorer, the custom task pane is not displayed.

When the user inserts a new text element at the beginning of the document, all text

content in the document is copied into the new element.

This issue involves a Quark XML Author configuration that includes embedded Word

documents and a Word template supplies custom Word styles in the embedded Word

authoring session. If that Word template is read-only then any attempts to create new

document fail. Any attempts to open existing documents based on that configuration also

fail. Technical Details: The issue occurs if the configuration contains an Element Definition

for an OLEWordDocument and the Word template (.dotx) specified in the

tableStylesTemplate is read-only.

If a table's structure is changed, ordered lists within the table lose their styling. For example,

deleting a table row or column causes this issue.

When the user creates a new embedded Word document, an extra paragraph is

inappropriately being added at the beginning of the new document.

The Insert Picture and Insert Equation features fail if the location is within Endnote text.

The user cannot apply certain emphasis to text in an Endnote. When the user selects text

to emphasize, the Emphasis control should display the “Normal” option. Instead, the

“Normal” option is missing and the emphasis option that follows “Normal” in the list is

displayed. That emphasis cannot be applied, but all other options in the list can be applied.

The Insert Table feature fails if the XML Author configuration contains an Element

Definition for a Table Row that includes multiple TableCellType definitions.
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After the user pastes a large amount of standard Word content (sixty plus pages), Quark

XML Author is not properly releasing memory that was used by the Smart Paste feature.

Eventually the system displays the error message, "System out of memory."

If a document has not been previously saved, the AutoSave feature fails and any content

is lost in the recovered document.

The user should be prevented from emphasizing text within a Footnote. However, the

system allows this action and the document is corrupted.

The AutoSave feature fails if the document contains an image. When you open a recovered

document, the document is corrupted.

Text that is entered immediately after a hyperlink (or cross-reference), is inappropriately

receiving the hyperlink emphasis even though the text is not part of the hyperlink.

Fixes 4.5.1.1
In a Quark XML Author document in Word 2003, all of the menus are Word menus. The

Quark XML Author menus are missing. In addition, all toolbars are missing.

The Refresh Picture feature fails and displays the broken image reference icon on the Word

canvas, if the operating system is Japanese Windows.

The Refresh Reference feature fails, if the input mode is set to Japanese.

If a local image is inserted that contains Japanese characters in the image filename, the

image is not displayed on the Word canvas. The image is displayed if the image reference

is refreshed or if the document is re-opened.

Fixes 4.5.1
When the indentation of a list item is changed or when the Change To feature is used to

change a list item to a different list type or to a paragraph, those items are inappropriately

styled using the Word built in template. The items should be styled using the configuration’s

template.dotx template.

Updated Fix: When the user changes focus from a standard Word document with certain

macros to a Quark XML Author document, attempts to invoke the Context Menu fail.

In the Spell Check dialog box, the button that should display the label “Undo” is blank.

When a change is made to a content element style that is based on Word’s Normal style,

the new styling is not used. Instead the display changes to Word’s Normal style.

The View Gridline feature fails for tables defined without a frame in the configuration.

When a cross-reference is inserted to text that is emphasized, the text displayed in the

cross-reference is incorrect.

For a table that contains Instructions, if the Instructions are hidden and then shown, the

Instructions are displayed outside of the table.

With track changes on, typing over a selection of text corrupts the text.
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The Widow Orphan feature is not available for table cell text.

The Keep With Next feature fails for Figure and its components.

The Keep With Next feature now supports table rows.

Erroneous line breaks are being included in the Transform Engine pretty-print output.

Using Shift + Insert accelerator keys to paste text over selected text, destroys the following

Empty.

For equations that are larger than the Microsoft Word galley, the equation’s size or aspect

ratio is corrupted when the document is re-opened.

Fixes 4.5.0.6
Making structural changes to a table, such add/delete rows/columns, causes ordered lists

in table cells to lose their formatting.

Fixes 4.5.0.5
If the user opens a Quark XML Author document that contains an inline equation and

right-clicks within the document, an error message is displayed. This occurs with an XML

Author configuration, where the definition of an equation does not include width and

height attributes.

Related to the following 4.5.0.3 fix “When the user changes focus from a standard Word

document with certain macros to a Quark XML Author document, attempts to invoke the

Context Menu fail.”, if Mathtype macros are present, error messages are displayed when

the user changes focus.

Several Quark XML Author temporary files are available in the Windows Recent Items

features. These files should not be accessible.

A shaded background is not displayed when a content reference is initially created. A

shaded background is displayed when the document is reopened. This issue occurs if the

element definition contains a referenceAttribute with an associated namespace. For example,

the standard - reserved xlink namespace, "xlink:href".

The Spell Check feature displays an error message in the following scenario. The document

contains more than twenty five spelling errors. The user invokes Spell Check and clicks

Ignore Once for each error. The user adds new misspelled content and invokes Spell Check

again. An error message displays though not immediately. In addition, the Spell Check

feature should not include misspelled content that is read-only in the spell check process

and should not present this content to the user. This can also prevent the Spell Check

dialog from closing automatically.

Fixes 4.5.0.4
In an attribute definition for an ID, if the xmlname contains a colon, the ID value in a

corresponding content element is inappropriately regenerated.

Copy / Paste of multiple elements fails for some Save transforms.
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In a Word document, if multiple headings at the same level are copied and then pasted

into a Quark XML Author document, the Smart Paste feature inappropriately nests the

content rather than pasting them at the same level.

Content is lost when the user presses the Space key with the cursor at the end of an element

that is assigned a numbered style. In a Quark XML Author document, Word’s "AutoFormat

As You Type > Set left and first indent with tabs and backspaces" feature inadvertently

causes the behavior. This feature is not needed and is now disabled within a Quark XML

Author document.

Fixes 4.5.0.3
If the Set List Numbering feature is used within a table cell, subsequent attempts to open

the document fail.

The Find and Replace feature fails if the selection includes reserved spaces within Quark

XML Author element bookmarks.

When the user changes focus from a standard Word document with certain macros to a

Quark XML Author document, attempts to invoke the Context Menu fail.

The text selection behavior of the New Comment feature in Quark XML Author does not

act the same as the New Comment feature in Word.

When the user selects a comment bubble, reposition the cursor in the Review/Comment

Pane and allow the user to edit the comment. This allows Quark XML Author to capture

changes and support Undo of those changes.

Fixes 4.5.0.2
Pressing the Delete key at the end of a paragraph fails to merge content of the following

paragraph into the current paragraph.

The custom Word task pane fails to display when the user opens a Quark XML Author

document, if the Word executable not already running. In Windows Task Manager, the

Word executable shows as "winword.exe".

Fixes 4.5.0.1
The Keep With Next feature is failing on Figures that contain an Image, Title and

Description.

The Smart Paste command is not enabled for Word tables. Namespace processing has been

improved to support additional use cases.

In some scenarios, the Paste Table feature is not enabled.

Pasting text using the Shift+Insert accelerator key deletes the next Empty.

Fixes 4.5
The system is not correctly styling table cell bottom borders as specified by the configuration

tableBorderBottomStyle attribute.
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Fixes 4.4.1.1
In several use cases, the increase and decrease indent buttons are incorrectly enabled.

Enabling is not honoring established indent rules logic.

Undo of Paste Special fails.

Fixes 4.4.1
Open document fails if more than one table cell in a given column has ascending or

descending text direction.

In a new Quark XML Author Business document, the Emphasis buttons are incorrectly

enabled when the cursor is in an Insertion Point.

Double-clicking a .dita or .ditamap file fails to launch Quark XML Author. The Installer

does not correctly associate these extensions with Quark XML Author.

Page breaks are not honored when they are within referenced content. For example, a

content reference of a section containing a page break does not break properly.

SmartPaste fails on emphasized empty paragraphs. For example, SmartPaste should ignore

bolded blank lines copied from Word.

Pressing Backspace with no selection at the beginning of a Title element corrupts the

document.

Autosave fails when the document contains images. The resulting autorecovered documents

cannot be opened.

After using the Save As feature, some Extensibility Interface calls fail.

Some equations that were inserted in earlier versions of Quark XML Author display smaller

in later versions. See similar issue for images in Fixes 4.3.3.2.

Fixes 4.4
The proprietary attribute qxa:read-only has been added to enhance Quark XML Author’s

ability to prevent the editing of read-only elements. Previously, referenced or embedded

images that were designated as read-only could still be resized, regardless of the reference

implementation being used. This scenario can now be prevented.

Fixes 4.3.3.4
If the Set List Numbering feature is used within a table cell, subsequent attempts to open

the document fail.

Related Fixes 4.3.3.2
Some images that were inserted in earlier versions of Quark XML Author display smaller

in later versions. This fix is related to the following enhancement in 4.3.2. Image processing

has been enhanced to prevent the insertion of image files named with the incorrect file

extension and image files that contain incorrect binary signatures.
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Fixes 4.3.3
The Keep With Next feature fails on table cell content.

Using the Split Table Cell feature multiple times corrupts the document.

There are several scenarios in which the user is able to position the cursor inside a bookmark

and type. The document is now corrupted.

Occasionally, typing in an Empty creates erroneous blank lines on the Word canvas that

are neither Empties nor content elements.

Fixes 4.3.2
Table cell merge fails if any of the cells selected for the merge does not contain a text

element.

The list Continue Numbering feature fails when lists contain a single item.

If Word is not already running and an XML Author document is opened, the custom task

pane is not displaying. In addition, the task pane cannot be displayed manually using its

"view" button.

The Context Menu is inappropriately displayed after certain Table features are executed.

Given table cells with content, merging all cells in a column causes Word to crash and

corrupts the document.

In the References Pane, the Go To feature fails when invoked on a reference that is an

inline image. The Word canvas does not scroll to display the inline image associated with

the reference.

When invoked for a referenced Section, the Refresh Reference feature corrupts the

document. In addition, the feature inappropriately deletes the associated reference in the

References Pane.

In the French version of Quark XML Author, the label of the View tab is incorrect.

Double-clicking on a Quark XML Author document with a custom file extension, fails to

open the document.

The Refresh Picture and Replace Picture features fail for an inline image that is embedded

in an emphasis.
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Known Issues

This section describes significant known issues in this version of Quark XML Author.

The details provided apply to the core Quark XML Author functionality which is a

component of all Quark Content Management System Adapters.

Known Issues 4.6
In a Quark XML Author document, Track Changes is not supported for the insertion or

deletion of an embedded Word document.

Within an Endnote, the Insert Picture/Equation Inline feature fails. The selected picture

or equation is not inserted.
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Warnings

This section describes any issues or changes to this version of the Quark XML Author that

are considered higher-risk.

The installation process now uses the Microsoft Windows Installer in order to be UAC

compliant. Be aware that the Windows Installer may or may not require a reboot and it

may or may not reboot automatically depending on the version of the operating system

and Windows Installer currently on the system. Quark recommends you save all work prior

to launching the installation process. For example, in all versions of XP the system prompts

you to reboot and in Vista SP1 or earlier the system reboots automatically. For more

information on the behavior of the Microsoft Windows Installer, see

http://support.microsoft.com/kb/958655.

All pre-4.0 configurations must be updated.

Table templates are not backwards compatible. New table templates must be created for

pre-4.0 solutions.

Outline View
Modifying a Quark XML Author document in the Outline View may corrupt the document.

Ruler
Any changes made using the Ruler feature are not saved in the Quark XML Author

document.

Spell Check
The Spell Check feature uses the default dictionary of the current Microsoft Office Display

Language.

Word 2007
When the Overtype feature is enabled, Quark XML Author occasionally deletes the adjacent

Empty/Insertion Point and corrupts the document.

The Quick Access Toolbar is presented for both standard Word documents and Quark XML

Author documents. Word commands that can change a document may corrupt a Quark

XML Author document and therefore should not be executed from the Quick Access

Toolbar.
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Word 2010
When the Overtype feature is enabled, Quark XML Author occasionally deletes the adjacent

Empty/Insertion Point and corrupts the document.

Quark recommends using the XML Author Open feature rather than the standard Word

Open feature whenever possible. When opening XML documents, this gives Quark XML

Author additional opportunities to perform checks and validations as the document is

opening. If Word prompts you with the message “DTD is prohibited”, please ensure that

you are using the XML Author Open feature so that the document opens properly.

The Quick Access Toolbar is presented for both standard Word documents and Quark XML

Author documents. Word commands that can change a document may corrupt a Quark

XML Author document and therefore should not be executed from the Quick Access

Toolbar.

Word 2010 allows the Ribbon to be customized. Quark XML Author hides standard Word

features from the Ribbon that do not apply to an XML authoring session and that could

corrupt a Quark XML Author document. Please consult with Quark professional services

before customizing the Word 2010 Ribbon so that you do not expose these types of features.

The Word 2010 Navigation Pane is not supported. Because the Document Map and

Thumbnail View are part of the Navigation Pane, they are also not supported. Standard

Quark XML Author solutions do not offer the Document Map and Thumbnail View.

However, if you want to use these two features in a Word 2007 Quark XML Author solution,

please consult with Quark professional services about creating a separate configuration to

facilitate this.

Word 2010 co-authoring / simultaneous multi-user authoring is not supported.
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Setting the Display Language for
Microsoft Word 2007

The Display Language of the user interface (menus, buttons, dialogs, etc.) in Microsoft

Word may be set to any language for which you have installed Microsoft Office Language

Packs.

Quark XML Author supports the following Display Languages within Microsoft Word:

English, French, Japanese and Spanish.

To set the display language:

1 Launch the Microsoft Office Language Settings applet.

For example, for Windows 7 the typical menu path is:

Start > All Programs > Microsoft Office > Microsoft Office Tools > Microsoft Office 2007

Language Settings

2 Click the Display Language tab.

3 In the Display Microsoft Office menus and dialog boxes in: drop down list box, select

the desired language.

4 Click OK.

5 Restart Microsoft Word.

The display language is set.
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Setting the Display Language for
Microsoft Word 2010

The Display Language of the user interface (menus, buttons, dialogs, etc.) in Microsoft

Word may be set to any language for which you have installed Microsoft Office Language

Packs.

Quark XML Author supports the following Display Languages within Microsoft Word:

English, French, Japanese and Spanish.

To set the display language:

1 Launch the Microsoft Office Language Settings applet.

For example, for Windows 7 the typical menu path is:

Start > All Programs > Microsoft Office > Microsoft Office 2010 Tools > Microsoft Office

2010 Language Preferences

2 In the Choose Display and Help Languages – Display Language list box, select the

desired language.

3 Click Set as Default.

4 Click OK.

5 Restart Microsoft Word.

The display language is set.
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Contacting Quark

If you have questions about installing, configuring, or using this software, please contact

Quark Software Inc.

In the Americas

For technical support, please use our free live online chat at support.quark.com, call the

incident-based support line at 800.676.4575 between 12:00 a.m. Monday and 6:00 p.m.

Friday (Mountain Time), or send an e-mail message to techsupp@quark.com.

For product information, please visit the Quark Web site at www.quark.com, or send an

e-mail message to cservice@quark.com.

Outside the Americas

In Europe, technical support is available by live online chat at support.quark.com or

euro.quark.com and by phone between 8.30 and 17.30 Central European Time, Monday

to Friday. Use one of the following local toll-free numbers:

• Belgium: 0800-77-296

• Denmark: 8088-7070

• France: 0800-91-3457

• Germany: 0800-180-0101

• Ireland: 1800-55-0241

• Italy: 800-87-4591

• Luxembourg: 8002-3861

• The Netherlands: 0800-022-7695

• Norway: 800-1-4398

• Spain: 800-1-4398

• Sweden: 020-790-091

• Switzerland: 0800-55-7440
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• UK and Ireland: 0808-101-7082

In some cases, a toll-free number may not be accessible via a mobile device. In such cases,

please use a land line.

For e-mail support in Europe, use live online chat or one of the following addresses:

• English: eurotechsupp@quark.com

• German: techsupportde@quark.com

• French: techsupportfr@quark.com

• Italian: techsupportit@quark.com

• Spanish: techsupportes@quark.com

In Australia, please use live online chat or call 1 800.670.973 between 10:00 a.m. and 7:00

p.m. Sydney Time (AEST), Monday through Friday, or send an e-mail message to

austechsupp@quark.com.

In Japan, please use live online chat or call (03) 3476–9440 (Monday through Friday, 10:00

am – 12:00 pm and 1:00 pm – 5:00), send a fax to (03) 3476–9441, or visit the Japanese

Quark Web site at japan.quark.com.

In countries not listed above, please use live online chat or contact your Quark Full Service

Distributor for technical support. For a list of Quark Full Service Distributors, visit the

Quark Web site at www.quark.com, euro.quark.com, or japan.quark.com.

For product information, please visit the Quark Web site at euro.quark.com or

japan.quark.com, or send an e-mail message to one of the following addresses:

• English: eurocservice@quark.com

• German: custservice.de@quark.com

• French: custservice.fr@quark.com

• Italian: custservice.it@quark.com

• Spanish: custservice.es@quark.com
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Legal Notice

©2022 Quark Software Inc. and its licensors. All rights reserved.

Protected by the following United States Patents: 5,541,991; 5,907,704; 6,005,560; 
6,052,514; 6,081,262; 6,633,666 B2; 6,947,959 B1; 6,940,518 B2; 7,116,843, 7,463,793; 
and other patents pending.

Quark, the Quark logo, Quark XML Author are trademarks or registered trademarks of 
Quark Software Inc. and its affiliates in the U.S. and/or other countries. All other marks 
are the property of their respective owners.

Contact Information
970 Lake Carillon Dr.

Saint Petersburg, FL 33716

(727) 822-7200 voice

(727) 822-7423 fax
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